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Tabs3 Trust Accounting Guide

Purpose of Guide

This Trust Accounting Guide covers the process of data entry and day-to-day tasks in the Tabs3
Trust Accounting Software, including creating trust accounts, entering payees, and writing checks.

The Administrator Guide includes information on initial setup and configuration of the Trust
Accounting software including customization, attorneys, bank accounts, the FIRM payee, how to
post balances, where to purchase checks, and how to configure check printers.

All guides are available on our Web site at:

Tabs3.com/support/docs.html

Introduction

Tabs3 Trust Accounting Software (TAS) was created as a tool to help law firms keep track of trust
accounts that they manage. Checks written out of the trust check book, electronic funds transfers,
and deposits made to the trust checking account are entered into the system providing current
balance information for each individual trust account. Check registers can be printed for bank
accounts, individual trust accounts, or payees. TAS will help you keep the strict control you need
over trust accounts.
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Trust Accounts

Menu: File | Open | Trust Account
Home: All Actions | Trust Accounts | Trust Account Information

Trust accounts are individual records used to track activity for trust clients. Before you can begin
entering trust transactions for a client, they must have a trust account configured.

When integrating Trust Accounting with Tabs3 Billing, client and contact information is mirrored
between the two programs. Client information can easily be converted to trust account information
using the Trust Accounts program. Additionally, adding a new trust account for a client that does
not exist in Tabs3 will create client information in Tabs3 Billing.

When integrating with Tabs3 Billing, the Trust ID lookup window shows which matters already have
a trust account defined. The Bank column indicates the bank account or the label “Tabs3". Matters
with “Tabs3" in the Bank column do not have a trust account defined.

[i2) Trust ID Lookup O *
[ Show Inactive Bark Accounts [ Show Inactive Clents
Trust ID 2 Bank Mame Search Client Hame Work Description Resp ~
10200 Tab:3 gilbert/andewc  Gilbertidndrew C. Auto Accident
12001 Tabs3 klein/daniel p. Klein/Draniel P. Klein vs. Simmons Construction
[ 1am] 2[philp Real Esf isition | 1]
20001 Tabs3 peterzon gereral  Peterzon Insurance Co. General Legal Coungel
20002 Tabs3 petersoninzuran  Peterzon Insurance Co. Maintenance of Insurance Policies
41500 Tabs3 megaconstruction  MegaConstruction Corporation Corporate Merger - Megabuilders and BuilderCorp
850.00 1 white/kely white/Kelly Divarce 5
850.01 1 whiteskely “whiteK el Last Wwill & Testament 5 R
Filter Cancel Help

Figure 1, TAS Trust ID Lookup window

If using Trust Accounting without integrating with Tabs3 Billing, all trust account and contact
information must be added directly into Trust Accounting.

The Trust Accounts window consists of two tabs: the Address tab and the Balances tab.
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Address Tab

The Address tab consists of preliminary name and address information for the trust account.

Trust Account Information EI@
Address Balances
Trust ID: | 101.00 v
Bank Account: v First Bank IOLTA Account
Federal ID #:
Client Name: | Williams/John v John Williams

Waork Description: | State v, Williams

Other* - 21_225 Amberwood
Chicago IL 60662

MName Search: | Williams/John |

Contact Name: | williams/John | v John Williams

Business | | 770-508-2354x45691 | Home v| | 770-598-2442 |
Mabile ~ | | Business Fax v | |

Figure 2, Trust Account Information Address tab

Trust ID

Bank Account

Federal ID #

The Trust ID field is a unique identifier used to distinguish
trust accounts for different client matters.

The Bank Account field identifies which bank account
funds are being deposited to (or withdrawn from) when
trust transactions are entered.

The Federal ID # field is used when 1099-MISC forms are
to be generated for trust accounts. The number entered
depends on whether the trust account or the firm will be
listed as the payer on the 1099 form.

The remaining fields on the Address tab are populated using data from the Contact file (page 70).
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Balances tab

The Balances tab includes the trust account balance as well as additional account information.

Trust Account Information

Lo & s

Address Balances

Trust ID: | 101.00 v
Bank Account: v First Bank IOLTA Account
Mame: Williams/John

Work Description: State v. Williams

Date Opened: 08/28/2018 | w
Responsible Attorney: v Paula Ann Martin

S a4l

Desired Minimum Balance: 2,000.00 Activity...
Tabs3 Billing
Automatically use Trust Balance to pay: 1Al Fee Exp Adv
Create auto transactions for amount of: | *Both current work and A/R ~

Amount to Bill: Target Balance: 3,000.00

Responsible Attorney

Current Trust Balance

Desired Minimum Balance

Figure 3, Trust Account Information Balances tab

The Responsible Attorney field is used to designate the
attorney responsible for the trust account. If integrating
with Tabs3, the Responsible Attorney file will mirror the
Tabs3 Timekeeper file.

The Current Trust Balance displays the amount currently
available in the trust account. This field defaults to 0.00
when a new account is created and updates each time a
trust transaction is entered to the trust account.

The Desired Minimum Balance field is used to define the
balance you want to maintain in a client's trust account. If
this field is set to an amount other than zero and a
transaction is entered that brings the client's trust balance
below the desired minimum, a warning will be displayed .
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Activity Clicking the Activity button displays a history of the trust
account'’s last check, deposit, and EFT, along with the
amounts of these transactions and the date the
transactions were posted. Totals for all checks, deposits,
and EFTs are also displayed.

Automatically use Trust Balance to The Automatically use Trust Balance to pay field is used

pay to configure individual trust accounts to use automatic
trust payments. The All, Fee, Exp, and Adv check boxes
allow you to select the type of transactions that will be
paid by automatic trust payments.

Create auto transactions for The Create auto transactions for amount of field is used
amount of is used to specify the method to use when paying due
amounts.

More Information: Detailed information on Automatic
Trust Payments can be found in TAS Help.

Amount to Bill The Amount to Bill field is used to enter a fixed amount to
bill when a Tabs3 statement is run, provided that the trust
account's Current Trust Balance is below the Desired
Minimum Balance.

Target Balance The Target Balance field is used in order to calculate a
specific amount to bill when a Tabs3 Billing statement is
run. The exact amount to bill amount is determined by the
difference between the amount entered in the Target
Balance field and the trust account's Current Account
Balance, provided that the difference is not zero and the
Current Trust Balance is not greater than or equal to the
Desired Minimum Balance.

Example: Suppose that the Target Balance is $500, the
Desired Minimum Balance is $600 and the Current Trust
Balance is $400. When a statement is run in Tabs3 Billing,
Tabs3 Billing will compare the Current Trust Balance of
$400 to the Desired Minimum Balance of $600. Since the
Current Trust Balance is less than the Desired Minimum
Balance, Tabs3 Billing will calculate the difference
between the Target Balance and the Current Trust
Balance (i.e., $500 - $400) and will print the message
“Please Remit $100.00" at the end of the statement.
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Steps for Adding a Trust Account

The exact steps used to create trust accounts differ slightly depending on whether you are
integrating with Tabs3 Billing. You can use the following procedures to create a trust account:

« Adding a new trust account when using Tabs3 Billing and the client is in Tabs3
« Adding a new trust account when using Tabs3 Billing and the client is not in Tabs3
« Adding a new trust account when not using Tabs3 Billing

» To add a new trust account when using Tabs3 Billing and the client is in Tabs3

1. From the File menu, select Open, and then click Trust Account.
2. Click the drop-down button next to the Trust ID field to open the Trust ID lookup window.
a. Select the desired Trust ID. All Trust IDs with the text “Tabs3" in the Bank column
indicate the client is in Tabs3 Billing but does not have a trust account created yet.
b. Click OK.
3. You will be returned to the Trust Account Information window.
a. Enter the Bank Account.
b. Enter the Federal ID # (if desired).
c. If you want to edit any contact information, click the hyperlink to the right of the
Client Name to open the Contact Information window. Enter the desired information

and click B to save the contact. You will be returned to the Trust Account

Information window.
d. Click the Balances tab.
1. The Date Opened defaults to the current date. Edit this date if desired.
2. The Responsible Attorney defaults to the client's Primary Timekeeper from
Tabs3 Billing. Edit this timekeeper if desired.

4. Click E__.I to save the new trust account.

» To add a new trust account when using Tabs3 Billing and the client is not in Tabs3

1. From the File menu, select Open, and then click Trust Account.

2. Click L on the toolbar to accept the next available Trust ID or enter a unique, unused

Trust ID.
a. Enter the Bank Account.
b. Enter the Federal ID # (if desired).
3. Enter the Client Name in Last/First format and press the Tab key.
a. Inthe Contact Information window, enter the contact information for the trust

account.
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b. Click B to save the new contact. You will be returned to the Trust Account
Information Window.

4. Click the Balances tab.
a. The Date Opened defaults to the current date. Edit this date if desired.

b. Select a Responsible Attorney from the drop-down menu.

5. Click EI to save the new trust account. The client will also be created in Tabs3 Billing.

» To add a new trust account when not using Tabs3 Billing

1. From the File menu, select Open, and then click Trust Account.

2. Click L on the toolbar to accept the next available Trust ID or enter a unique, unused
Trust ID.
a. Enter the Bank Account.
b. Enter the Federal ID # (if desired).
3. Enter the Client Name in Last/First format and press the Tab key.
a. In the Contact Information window, enter the contact information for the trust
account.
b. Click E_J to save the new contact. You will be returned to the Trust Account

Information Window.
4. Click the Balances tab.

a. The Date Opened defaults to the current date. Edit this date if desired.

b. Select a Responsible Attorney from the drop-down menu.

5. Click E_J to save the new trust account. The client will also be created in Tabs3.
A single Trust ID can be linked to multiple bank accounts by creating additional Trust Accounts.

» Creating additional trust accounts for the same client

1. After creating the first trust account, click the drop-down next to the Bank Account field.

2. Select the next bank account that the client has funds deposited to. The word “New" will
appear next to the Trust ID field, indicating that the account is separate from the funds in
the first bank account.

3. Make any necessary changes to the remaining information and click B to save your
changes.
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Contacts

Menu: File | Open | Contact
Home: All Actions | Trust Accounts | Contact

Contacts are the people or organizations you interact with in the process of doing business on
behalf of the firm or your clients. The Contact file is used to store information such as name, phone
number, address, and email address.

E Contact Information EIIEI
Contact ID: ‘ St. Elizabeth Hospital [Tinactive
Full Name: ‘ St. Elizabeth Hospital |
O Individual ® Organization
Organization: st. Elizabeth Hospital
Business* ~| | 555 S, 70th St. Details
Lincoln NE 88510
Default Address
Business ~ ‘ 402-219-8000 | Home ~ | |
Business Fax v ‘ | Mobile ~ | |
Email 1* o ‘ | =
Web Page: ‘ www.saintelizabethonline.com | &
Comments:

Figure 4, TAS Contact Information

More Info: A detailed explanation of contacts, including instructions on how to add, change, and
delete contacts, can be found in the TAS Help or in the Clients & Contacts Guide.

-10-
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Payees

Menu: File | Open | Miscellaneous | Payee
Home: All Actions | Setup | Payees

Payees are people or business entities to whom checks or electronic funds transfers (EFTs) are paid.
You can optionally print 1099-MISC forms for payees (page 30).

Miscellaneous EI@

Attorney Payee  Bank Account

Payee Marne: | Bryan/LGH East Medical Center

Payee Address Line 2: | Lincoln, NE 68506

|
Payee Address Line 1: | 1600 South 48th Street |
|
|

Payee Address Line 3: |

Federal ID #; 47-5205856

1099 Info: Box 6 “

L P Y o U B T WP P

Figure 5, Payee tab

» To add a payee

1. From the File menu, select Open, and then click Miscellaneous.
2. Click the Payee tab.

3. Click ~ to determine if the payee exists. If not, close the Payee Lookup window and enter
the payee name using a "Last/First” format for individuals and a “First Last” format for
organizations.

4. Enter the information for the payee.

=]
5. Click to save the new payee.

Firm Payee

If integrating with Tabs3, you will need to create a FIRM payee. The FIRM payee is used when writing
checks from a client's trust account to pay for billing or other expenses owed to the firm. When
integrating with Tabs3 Billing and Tabs3 General Ledger Software, the FIRM payee also creates a
payment record in Tabs3 along with journal entries in GLS.

More Info: Complete instructions on creating a FIRM payee can be found in the TAS Help or the
Administrator Guide.

11 -



Tabs3 Trust Accounting Guide

Trust Transactions

Menu: File | Open | Transaction
Home: All Actions | Checks/Deposits | Trust Transactions

Trust transactions make up the activity that establishes a trust account balance. The most common
trust transactions are deposits and check transactions. TAS recognizes two types of checks.
Handwritten checks, also known as manual checks, are entered into TAS with a check number.
Checks to be printed from TAS are entered into TAS using a check number of 0. When the check is

printed, the check number is automatically assigned.

E Trust Transaction Entry

(= [E s

Transaction Tabs3

Trust ID: | 121.01 v Phillips/Marcus
Real Estate Acquisition

Bank # v First Bank Interest Bearing
Reference: v

EFT 0
Date: 10/30/2018 | v Amount:
Description: Real Estate Taxes Balance: 7,696.49
Memao: | lic]
Payee Name: | D & B Real Estate Management Co. w [l add Payee

Payee Address 2: | P.0. Box 64352 User ID: | DAN

|
|
Payee Address 1: | 7589 Van Gogh Street | Status: | Outstanding ~
|
|

<

Payee Address 3: | Lincoln, NE 68501

Date Entered: | 10/30/2018 | v

Trust Transaction Entry List Trust ID: 121.01  Bank #: 2

Ref # Date Check # Amount Description

1 07/27/2018 Deposit 10000.00 Initial Deposit

2 08/21/2018 4544 267.00 Papment of July Invoice

3 09414/2018 Deposit 1217 Interest Eamed for August

4 09/25/2018 4545 167.50 Payment of August Invoice

E 10/26/2018 4546 Woided Payment of September Invoice
7 10/26/2018 Unpaid 1437.43 Payment of September Invaice

o

Deposits: 10,012.17 Credit Cards: 0.00 EFTs: 443.75 Checks: 1,871.93

Amount: 7,696.49

Figure 6, TAS Trust Transaction Entry - Transaction tab

-12-
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Trust Transaction Entry

Trust Transactions tab
Five types of trust transactions can be entered using the Trust Transactions program. The
Transaction tab is used to enter detailed information regarding each trust transaction.

More Info: Many of the fields in the Trust Transaction Entry program are self-explanatory. Those
fields that require additional explanation are described below. The TAS help includes detailed
descriptions of all fields used in the Trust Transaction Entry program.

Reference The Reference field is used as a placeholder to identify
individual transactions. This unique number can be used
to retrieve transactions for editing purposes.

Type The Type field is used to classify a transaction using one of
five categories:

« Check - The Check transaction type is used to
enter check transactions. If you select Check, you
will be asked to enter a Check # and Payee. Check
transactions reduce the trust account balance.
Negative check transactions are not allowed.

« EFT - Select EFT to enter an electronic funds
transfer transaction. If you select EFT, you can
enter a Payee. Positive EFT transactions reduce the
trust account balance. Negative EFT transactions
are allowed, and will increase the trust account
balance.

« Deposit - Select Deposit to enter a deposit
transaction. Positive deposit transactions increase
the trust account balance. Negative deposits are
allowed, and will decrease the trust account
balance.

« Credit Card - Select Credit Card to enter a deposit
transaction via a credit card when configured to
perform credit card processing. Credit card
transactions increase the trust account balance.
Negative credit card transactions are not allowed.

13-
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Status

Add Payee

» To add a new trust transaction

More Info: Detailed information regarding credit card
processing and credit card transactions can be found in
the Tabs3 Credit Card Authorization Guide.

« Voided - Select Voided to enter a voided

transaction. When a voided transaction is entered,
it does not affect the bank account or the trust
account balances. It will be saved with an amount
of 0.00. This option is selected automatically if a
check is voided using the TAS Void Checks
program (page 17).

The Status field is used to indicate the status of the
selected transaction.

Cleared - A status of Cleared indicates that the
transaction has been cleared in the Reconciliation
program. Each journal entry or deposit with a
check mark in the “Clr” (Cleared) column in the
Reconciliation window is considered Cleared. The
Cleared status is changed to Reconciled when the
reconciliation is finalized.

Outstanding - A status of Outstanding indicates
that the transaction has not yet been cleared or
reconciled using the Reconciliation program.

Reconciled - A status of Reconciled indicates that
the transaction has been reconciled using the
Reconciliation program.

The Add Payee check box is used to add a new payee to
the Payee file without leaving the Trust Transactions
program. If this box is selected when entering a trust
transaction with a payee that does not exist in the Payee
file, the payee will be added to the Payee file upon saving
the record. Use this check box when the payee will be
used more than once.

1. From the File menu, select Open, and then click Transaction.
2. Click the Trust ID button and select the desired trust account.

3. Click L_ to enter a new transaction.

-14-
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4. Enter the desired information for the trust transaction.
. = .
5. Click to save the new trust transaction.

More Info: Additional steps are required for firms who are configured to enable credit card
processing for payments though TSYS Merchant Solutions>M. Detailed information can be found
in the Credit Card Processing Guide.

Print Receipt

TAS allows you to print receipts for deposit
transactions. When saving a new deposit or
opening a previously saved deposit, click the

Trust Transaction Entry

Print Check/Receipt button (Figure 7) or
press Ctrl+Shift+P. A Trust Deposit Receipt L

Print Check/Receipt (Ctrl+5Shift+P) i
Transa o ——rgmss

including information included in the
deposit transaction will be generated (Figure

St ot et s me  pmm am

8). Figure 7, Print Receipt icon
Date: 11/26/2018 Trust Deposit Receipt Page: 1
Jensen, Martin & Anderson, P.C.
Trust ID: 101.00-01 Williams/John
State v. Williams

Receipt Type: Deposit Received By: DAN
Reference: 4 Date: 10/29/2018
Description: Retainer Payment Received

Amount: 1,923.40

Figure 8, Trust Deposit Receipt

Tabs3 Tab

If integrating with Tabs3, a Tabs3 tab will also be available. This tab is used to enter payment
amounts that are posted to Tabs3 upon saving the transactions. This tab is only accessible when
entering a transaction type of Check or EFT with a payee of FIRM.

. S W R

-15-
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B Trust Transaction Entry

Transaction Tabs3

Trust ID: 121.01

Bank #: 2

Total Amount: 143743

Phillips/Marcus
Real Estate Acquisition

First Bank Interest Bearing

Payment Type Tcode  Descriptior

Regular: 900  Payment
Fee:
Expense:

Advance:

Total Left to Apply

Amount

1,437.43

=1
=]
=]

=]
=1
=]

=]
=1
=]

0.00

Trust Transaction Entry List Trust ID:

Ref # Date Check # Amount
2 08/21/2018 4544 267.00
3 09/14/2018 Deposit 1217
4 08/25/2018 4545 167.50
B 10/26/2018 4546 Woided
=
5 1043072018 EFT 443.78

Deposits: 10,012.17

121.01 Bank# 2

Description

Payment of July Invoice
Interest Eamed for August
Payment of August Invoice
Payment of September Invoice

Fayment of September Invoice

Fieal Estate Taxes

Credit Cards: 0.00 EFTs: 44375

Checks: 1,871.93

Payee
FIRM

FIFit
FIRM
FIRH

il
fi

CE

D & B Real Estate M:

Amount: 7,696.48

Figure 9, TAS Trust Transaction Entry - Tabs3 tab

The amount of the check/EFT transaction will be displayed in the Total Amount field. When an
amount is entered in the Amount field for one of the Tabs3 transaction codes, the Total Left to
Apply field will be adjusted accordingly. Once the entire check/EFT transaction is fully distributed

amongst the desired Tabs3 transaction codes, the Total Left to Apply amount will be 0.00.

-16-
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Printing and Voiding Checks

The Print Checks program is used to print trust checks for specified trust accounts. Only trust
transactions with a check number of 0 are printed; checks with a check number other than zero are
considered manual checks and will not be printed. Checks can be individually printed from the Trust
Transactions program, or in batches from the Print Checks program.

Printing from the Trust Transactions Program

Menu: File | Open | Transaction

Home: All Actions | Checks/Deposits | Trust Transactions

You can print a check directly from the Trust Transactions program using the Quick Print function.
Simply select an unpaid check transaction and click E=IPrint Check/Receipt 4, display the printer

prompt.

Trust Transaction Entry

=N EOR )

| Print Check/Receipt (Ctl+ ShiftP) |

Reference: 7

Check

Transacrerr—raos
mustp: 12101 |v
Bank #: v First Bank Interest Bearing

Phillips/Marcus
Real Estate Acquisition

Date: 10/26/2018 | v Amount: 1,437.43
Description: Payment of September Invaice Balance: 7,696.49
Memo: ‘ Payment of September Invoice B

Payee Name: ‘ FIRM 4 [ add payee

Payee Address 1: ‘ 1621 Cushman Drive

Payee Address 2: ‘ Lincoln, NE 68512

User ID: | (BLANK)

Payee Address 3: ‘

|
|
| Cutstanding
|
|

W
w

Date Entered: | 10/26/2018

Trust Transaction Entry List

HRef # Date Check #
1 07/27/2018 Deposit

Deposits: 10,012.17

4 09/28/2018 4545
E 10/26/2018 4546
T

Credit Cards: 0.00

Trust ID: 121.01  Bank # 2
Amount Description Payee ~
1000000 Initial Depozit

167.50 Payment of August Invoice FIRM

“oided Papment of September Invoice FIRM

yment of 5

FIRk W

Checks: 1,871.83 Amount: 7,696.49

Figure 10, TAS Trust Transactions Quick Print option

-17-
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Printing from the Print Checks Program

Menu: Checks | Print Checks
Home: All Actions | Checks/Deposits | Print Checks

The Print Checks program consists of two tabs: the Trust Accounts tab and the Transactions tab.

The Trust Accounts
tab allows you to
select trust accounts
by specifying ranges
of trust accounts,
bank accounts,
responsible attorneys
and open dates.

The Transactions tab
allows you to select
trust transactions by
specifying ranges of
dates.

@5 Print Trust Checks EI@
Trust Accounts  Transactions
Trust ID: | | ¥ Thru: | | v Multiple...
Cancel
Load
Bank Account #: I:I v Thru: I:I hd Save
Responsible Attorney: I:I v Thru: I:I v
Open Date: mm/dd/yyyy | v Thru: | mm/dd/yyyy | v
Figure 11, TAS Print Trust Checks - Trust Accounts tab
&, Print Trust Checks EI@
Trust Accounts Transactions
Date: mm/dd/fyyyy | v Thru: mm/dd/yyyy | v
Cancel
Load
Type Save
Checks Deposits EFTs

Figure 12, TAS Print Trust Checks - Transactions tab

More Info: Detailed information on the Print Checks program can be found in TAS Help.

-18-
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Void Checks

Menu: Checks | Void Checks
Home: All Actions | Checks/Deposits | Void Checks

Manual checks and checks that have already been printed cannot be deleted but instead must be
voided. This process is performed using the Void Checks program. Voiding a check updates the bank
account balance as well as the balance of the trust account to which the check was written.

\_ Void Checks = =R =<

Williams/John
| State v. Williams

Trustip: | 10100

Bank #: V First Bank IOLTA Account
Check #: 4827 Thru: | 4627

Void Date: 11/17/2018 | v
Records Read: Voided:

Figure 13, TAS Void Checks program

-19-
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Combine Trust Transactions

Menu: File | Open | Combine Trust Transactions

Home: All Actions | Checks/Deposits | Combine Trust Transactions

The Combine Trust Transactions program is used to combine one or more check, EFT, or deposit
transactions into a single combined transaction. This simplifies the process of bank account
reconciliation by providing a single line item in TAS to match against a transaction on your bank
statement. You can create combined trust transactions before funds are taken to the bank, or after
the bank statement is received.

In Figure 14, the firm has
received a deposit from a
client for two separate
trust accounts. Each
deposit has been recorded
in TAS as a separate
transaction. Once the
deposit transactions are
entered using the Trust
Transactions program, the
Select Transactions
button (Figure 14) is used
to open the Select Trust
Transactions to Combine
window (Figure 15) to
select which receipts are to
be included in the deposit.

Combine Trust Transactions

== =]

Ref #:
Bank # First Bank IOLTA Account

Date:

11/18/2018 v

Deposits

Friday
Type:
Check #: 0
Total Amount: | 1,600.00

Status: | OQutstanding ~

Description: Client 850.00 & 850.01 (White, deposit) Selact Transactions..

Print Summary
Selected Transactions:

v TrustID Bank # Amount Description

Date

Figure 14, Combine Trust Transactions program

B Select Trust Transactions to Combine O X

Optional Filter
Trust ID: | “’ Thru: | |" cancel
Dater  |mmyddfyyy | v Thru |[mm/ceyy | v l

elp

Aftorney: |:| v

[ Trust ID Bank #
101.00 1 111542018
850,00 1 115/2018
=

[

Thru:

Date

Amount Description A
1633.58 Retainer Payment Received, Thank v'oul
1000.00 Deposit to replenish retainer.

v
v

Total Amount Selected:  1,600.00

Figure 15, Select Trust Transactions to Combine window

The following fields are shown in the Combine Trust Transactions window (Figure 14):

-20-
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Ref #

Type

Check #

Total Amount

Status

The Ref # field acts as a unique identifier for the currently
selected combined transaction. Pressing Enter will create a
new combined transaction with the next available number.

The Type field is used to specify the type of transactions
being combined. Transactions with different transaction
types cannot be combined. There are three types available
to combine.

o Checks - Select the Checks option if you want to
combine multiple unpaid checks into a single
check transaction. Combining multiple check
transactions allows you to create a single check for
a payee that is paid from multiple trust accounts.

« Deposits - Select the Deposits option if you want
to combine multiple deposits into a single deposit
transaction.

« EFTs - Select the EFTs option if you want to
combine multiple EFTs into a single EFT
transaction.

The Check # field is used to assign a check number to a
combined trust check. Combined checks are saved as a
manual check transaction in TAS and cannot be printed
using the Quick Print or Print Checks programs. This field
is only available when the Type field is set to Checks.

The Total Amount is a calculation based on the total of all
transactions in the Selected Transactions area of the
window that have a check mark. The amount cannot be
edited.

The Status field is used to indicate the status of the
selected transaction.

« Cleared - A status of Cleared indicates that the
transaction has been cleared in the Reconciliation
program. Each journal entry or deposit with a
check mark in the “CIr" (Cleared) column in the
Reconciliation window is considered Cleared. The
Cleared status is changed to Reconciled when the
reconciliation is finalized.
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« Outstanding - A status of Outstanding indicates
that the transaction has not yet been cleared or
reconciled using the Reconciliation program.

« Reconciled - A status of Reconciled indicates that
the transaction has been reconciled using the
Reconciliation program.

Check Mark (V) The Check Mark indicates that a transaction has been
selected to be included in the combined transaction and
counted as part of the Total Amount.

The Print Summary button in the Combine Trust Transactions window (Figure 74) can be used to
print a TAS Combined Transaction Summary (Figure 16).

Date: 11/26/2018 TAS Combined Transaction Summary Page: 1
Jensen, Martin & Anderson, P.C.

Bank Account: First Bank IOLTA Account

Bank Description: First Bank IOLTA Account

Account #: 6027-2913-8451

Deposit Date: 11/16/2018

Description: Client 850.00 & 850.01 (White, deposit)

Date Trust ID Description Amount
11/15/2018 850.00 Deposit to replenish retainer. 1,000.00
11/16/2018 850.01 Initial Deposit 600.00

Total Amount (2 items): 1,600.00
D 's e.

Figure 16, Combined Transaction Summary

» To add a new combined trust transaction

1. From the File menu, point to Open and then select Combine Trust Transactions.
2. Click L

a. Select the desired Bank #.

b. Select the Type of transactions you want to combine.

c. If combining checks, enter a check number in the Check # field.

3. Click the Select Transactions button to open the Select Trust Transactions to Combine

window.
a. Select the transactions you want to combine.
b. Click OK.

4. Enter a Description for the combined transaction.

5. Optionally, click the Print Summary button to generate a Combined Transaction Summary.

6. Click l:__l to save the combined trust transaction.
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Bank Account Manager

Menu: File | Open | Bank Account Manager
Home: All Actions | Trust Accounts | Bank Account Manager

The Bank Account Manager provides a summary view of all of the bank accounts in TAS. From this
window, you can view bank account information, see the date of the last import and reconciliation
performed for each bank account, and view the bank account's current balance. The Bank Account
Manager also provides access to the Import Bank Transactions, Confirm Transactions, and
Reconciliation programs.

Bank Account Manager =2 = |

Bank Account # Bank Name Last Import Last Reconciliation Balance ~
2 572643200 First Bank Interest Bearing o et revanst o seviadin reconds 913352

n 348340
477350

45 First Bark 101 unt / 6 unconfimed transactions 05 ]
3 9438041 Medical Care Account Moz et recordl No revevadiaiion records

Import Bank Transactions Confirm Transactions Reconcile Account [Ishow Inactive Banks

Figure 17, Bank Account Manager

Import Bank Transactions

Menu: Maintenance | Import Bank Transactions
Home: All Actions | Utilities/Maintenance | Import Bank Transactions

The Import Bank Transactions program allows you to import information via a file from your bank or
credit card company. File formats supported include the .OFX, .QFX, and .QBO file formats. During
the import process, TAS will automatically match the imported transactions with existing trust
transactions, and allow you to quickly create new transactions based on the imported transactions.
After transactions have been imported and matched, you can use the Confirm Transactions program
to “confirm” each match and mark each matched transaction as Cleared. This saves you time when
reconciling your bank account.

Note: More information on the Import Bank Transactions program can be found in TAS Help.
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E Confirm Bank Transactions EI

Unmatched matched

Description Date - Amount Type Check ## Reference -

Create Match

Figure 18, Confirm Bank Transactions Unmatched tab

[ Confirm Bank Transactions

Unmatched Matched

+ Source Description Date . Amount Type Check # Trust ID Payee -
3 CHECK.

Bank  CHECK 45333 11/15/2018 125.00 Check 45339 380643001
[ Payrnent for Auditing Fees 11/13/2018 125.00 Check 45339 1.001 Lancaster County Tre
Bank  DEPOSIT 1141772018 163358 Deposit 580312001

v 7 Rietainer Payment Received, Thank Youl 11/15/2018 1,633.58 Deposit 101.00-1
Bank  CHECK 45340 11425/20148 126.00 Check 45340 980328319

v 2 Payrnent of October Statement 11/23/2018 125.00 Check 45340 850.001 FIRK v
Edit Unmatch Confirm

Figure 19, Confirm Bank Transactions Matched tab
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Reconciliation

Menu: Checks | Reconciliation
Home: All Actions | Checks/Deposits | Reconciliation

Tabs3 Trust Accounting's Reconciliation program makes it easy to reconcile bank statements against
activity within the Trust Accounting Software. When starting the Reconciliation program, the
Reconciliation Settings window is displayed. From the Reconciliation Settings window, you can:

« Select the bank account account to reconcile

« Confirm the beginning balance automatically calculated by TAS

« Enter the ending balance from your bank statement

« Enterinterest and service charge information from your bank statement

Reconciliation Settings ] X

Bank Account: 1 First Bank IOLTA Account

Show Trust Account Information for each Trust Transaction

Statement Information

Statement Date: ~
Beginning Balance:
Ending Balance:
Adjustments
Interest: Trust ID:
Interest Date: mmy/dd,yyyy Bank:

Service Charge: Trust ID: 1.00 ¥ Administrative
Service Charge Date: | 11/30/2018 v Bank + First Bank IOLTA Account

I
=~

Cancel

Figure 20, Reconciliation Settings window

Once you have entered your Reconciliation Settings (Figure 20, the Reconciliation window (Figure
21) will be displayed. This window includes a list of outstanding journal entries and deposits, a
section for tracking cleared totals, and a section for tracking reconciliation balances.
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_- Reconciliation - 6027-2913-8451 First Bank |OLTA Account - 11/30/2018

Checks, EFTs, and Other Withdrawals

Clr Date

Check #

Amount

Description ”

Receipts and Other Deposits

Amount

10/26/2018 EFT 990,00 Papment
860.00-1 White/Kelly - Divarce
1042672018 EFT 1.076.60 Papment
101.00-1 wiilliamsAlohn - State v Willams
10/29/2018 45337 1.382.35 Papment of October Invoice
I/ 100001 ‘wiillizms Alohin - State v, Wiliams
10/23/2018 EFT 3.22 Interest transfered to |OLTA
v 1.00-1 Administrative Account - For tracking all Fim and
11413/2018 45338 251.23 Blood Testing - Direct Payment
1071.00-1 wiilliamsAlohin - State v Wiliams
NA208 4533 125.00° Payment for Audting Fees
1.00-1 Administrative Account - For tracking all Fim and
11/23/2018 45340 126.00 Payment of October Statement

B50.00-1 WwhiteKelly - Divorce

v
Cleared Withdrawals
2 Checks 2,105.75
1 EFTs 3.22
1 Service Charge 19.00
4 Total Withdrawals 2,127.97
Cleared Deposits
5 Deposits 6,160.20
0 Interest 0.00
5 Total Depasits 6,160.20

Clr  Date Type
v 10/25/2018  Deposit
I/ 10/23/2M8  Deposit
I/ 11/19/2M8  Deposit
|/ 11/16/2M8  Deposit

Reconciliation Balances

Statement Beginning Balance:

Cleared Withdrawals:
Cleared Deposits:

Cleared Balance:
Statement Ending Balance:

Difference:

Settings.

1.000.00 Initial Deposit - Check 2322
850,001 White/Kelly - Divorce

192340 Retainer Payment Recaived
101.00-1 Williams/)ohn - State v. Wiliams

163358 Retainer Papment Received, Thank Youl
107.00-1 Wwilliames A ohn - State v. Wiliams:

160000 Client 850.00 & 850.01 [white, deposit)
Combined Transaction

2,000.00
-2,127.97
6,160.20

6,032.23
5,931.00

101.23

Finalize

Figure 21, TAS Reconciliation

Once the reconciliation is in balance, click Finalize. Reconciliations cannot be finalized unless they

are in balance. You can print a Reconciliation Report for your records. TAS also stores Reconciliation
Reports as PDFs for later viewing.

More Info: Detailed information regarding the reconciliation process can be found in TAS Help.
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Date: 05/11/2018 TAS Detail Reconciliation Report Page: 1
Jensen, Martin & Anderson, P.C.
Bank Account #: 6027-2913-8451 First Bank IOLTA Account
Trust Bank: 1 As of the Period Ending
November 30, 2018

Cleared Checks

Date Check # TrustiD__ NamelDescription Payee Amount

10125/2018 45336 101.00 John Williams Jensen, Martin & Anderson, P.C. 723.40
Payment of September Invoice

11/13/2018 45338 101.00  John Williams Bryan/LGH East Medical Center -251.23
Blood Testing - Direct Payment

11/13/2018 45339 100  Administrative Account Lancaster County Treasurer -125.00

Payment for Auditing Fees

(-) Total Cleared Checks 3items 099.63
Cleared EFTs
Date Trust D Payes Amount
10/2612018 101.00 John Willams Jensen, Martin & Anderson, P.C. 1,076.60
Payment
10/29/2018 1.00  Administrative Account IOLTA Interest 3.22
Interest transferred to OLTA
11/30/2018 100  Administrative Account 175
Service Charge
() Total Cleared EFTs 3items 100157
Cleared Deposits
Date TrustID  Name/Description Payee Amount
102212018 1,00 Administrative Account 322
Interest Deposited
10/25/2018 850.00  Kelly Ann White 1,000.00
Initial Deposit - Check 2322
10/29/2018 101.00  John Williams 1,923.40
Retainer Payment Received
1111512018 101.00  John Williams 1,633.58
Retainer Payment Received, Thank You!
11/16/2018 Client 850.00 & 850.01 (White, deposit) 1,600.00
Combined Transaction
(+) Total Cleared Deposits 5 items 6,160.20
Balances
Statement Beginning Balance 2,000.00
Cleared Withdrawals 6 items -2,191.20
Cleared Deposits 5items 6,160.20
Cleared Balance 5,969.00
Statement Ending Balance 5,969.00
Difference In Balance
Date: 05/11/2018 TAS Detail Reconciliation Report Page: 2
Jensen, Martin & Anderson, P.C.
Bank Account #: 6027-2913-8451 First Bank IOLTA Account
Trust Bank: 1 Thru: 11/30/2018
Outstanding Checks
Date Check # TrustID  Name/Description Payee Amount
10/2912018 45337 101.00 John Williams Jensen, Martin & Anderson, P.C. 1382.35
Payment of October Invoice
1112312018 45340 850.00  Kelly Ann White Jensen, Martin & Anderson, P.C. -125.00
Payment of October Statement
(-) Total Outstanding Checks 2items -1507.35
o ing EFTs
Date TrustID  Name/Description Payee Amount
10/26/2018 850.00 Kelly Ann White Jensen, Martin & Anderson, P.C. -990.00
Payment
() Total Outstanding EFTs 1 item -990.00
(+) Total Outstanding Deposits 0items 0.00
Total Voided Checks 0items 000
Account Balances as of 11/30/2018
Statement Ending Balance 5,969.00
Total Outstanding Items 3items -2,497.35
Calculated Balance 347165
Total Unpaid Items. 1 item -885.00
Adjusted Bank Account Balance 2,586.65

Figure 22, TAS Detail Reconciliation Report
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TAS also includes an Undo Reconciliation
program, which allows you to reverse a
reconciliation in order to make any
necessary changes.

Undo Recenciliation ?

¥ First Bank IOLTA Account
09/30/2018 | v

Bank Account:

Statement Date:

Reconciliation Details

Bank Mame: First Bank IOLTA Account
Statement Beginning Balance: 2,200.00
Cleared Total: -200.00
Statement Ending Balance: 2,000.00

Undoing this reconciliation will delete the reconciliation record, and all
trust transactions included on the reconciliation will be available for
reconciliation.

Note that all cleared transactions will be retained. You will need to
reconcile your previous statement again.

Cancel

OK

X

Figure 23, Undo Reconciliation
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Three-Way Reconciliation Report

In some states, multiple forms of proof that trust bank accounts are in balance may be required. TAS
provides this proof via the Three-Way Reconciliation Report. The Three-Way Reconciliation Report
compares the following figures and provides a warning if a discrepancy is encountered.

« The total of all Client Trust Ledger balances

« The ending Statement Balance of the latest Reconciliation (plus all outstanding deposits and
minus all outstanding checks)

« The ending Check Register balance

Date: 11/30/2018 Trust Three-Way Reconciliation Report Page: 1
Jensen, Martin & Anderson, P.C.

First Bank IOLTA Account
As of the Period Ending
November 30, 2018

Bank Account #: 6027-2913-8451
Trust Bank:
Client Trust Ledger
TrustID  Trust Account Name/Description Amount Balance
1.00 Administrative Account 63.25
For tracking all Firm and interest adjustments
101.00  John Williams 1,923.40
State v. Williams
850.00 Kelly Ann White 0.00
Divorce
850.01  Kelly Ann White 600.00
Last Will & Testament
Client Trust Ledger Balances 2,586.65
Reconciliation Statement Ending Balance 5,969.00
Add Al Outstanding Deposits 0.00
Less All Outstanding EFTs -990.00
Less All Outstanding Checks -1,507.35
Less All Unpaid Transactions -885.00
Adjusted Bank A t 2,586.65
Check Register
Check Register Balance 2,586.65

Figure 24, Three-Way Reconciliation Report

-29-



Tabs3 Trust Accounting Guide

1099 Report

Menu: Reports | 1099 Information | 1099 Reports
Home: All Actions | 1099 | 1099 Reports

TAS allows you to generate IRS 1099-MISC forms on behalf of your trust accounts. 1099s are written
to the payee, whereas the payer can be either the trust account or the firm. The payer is determined
by the Federal ID number entered for the trust account. If the trust account's Federal ID number
matches the firm's Federal ID number, the firm will be the payer. If the trust account's Federal ID
Number does not match the firm's Federal ID number, then the trust account will be the payer. The
1099 Report is used to verify 1099 information before printing 1099 Forms.

The Trust Accounts

¢k 1099 Report = =R
tab aIIows yOU to Trust Accounts Options
select trust accounts
by specifying ranges Trust ID: | | ¥ Thru: | | v Multiple...
Cancel
of trust accounts,
bank accounts, Load
responsible attorneys Bank Account # | | v Th [ | Save
and open dates.
Responsible Attorney: I:I v Thru: |:| v
Open Date: mm/dd/yyyy | v Thru: | mm/ddfyyyy | v
Figure 25, TAS 1099 Report - Trust Accounts tab
The Options tab & 1099 Report =R =

allows you to select

Options
the Reporting Year

Trust Accounts

Type

for which you are
filing, a range of
payees for whom to
run the report, and a
Minimum

YTD Amount to
Print.

Report Date:

11/26/2018 | v

O Detail

@ summary

Reporting Year: | 2017
Minimum ¥YTD Amount to Print:

[Jstart Each Trust Account on a New Page

[ Print Criteria Page

Cancel

Load

Save

Figure 26, TAS 1099 Report - Options tab
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Additional Resources

With its intuitive data entry system and streamlined features, Tabs3 Trust Accounting Software makes
it easy to keep close track of all of your firm's trust information. This section includes additional
resources and information on the features discussed in this guide.

Help

The Help contains detailed information on all features of the software. The Help is accessible by
pressing F1 from anywhere within the software; doing so will load the Help information for the
particular feature being accessed.

Knowledge Base

Tabs3's extensive Knowledge Base is available 24 hours a day, 7 days a week. The Knowledge Base
can be accessed from within the software by selecting Help | Internet Resources | Knowledge
Base. You can also access the Knowledge Base from any Internet-enabled device by navigating to:

support.Tabs3.com

Report Pack
The Trust Accounting Report Pack makes it easy to familiarize yourself with the various reports
available and the criteria used to create them.

All guides and report packs are available on our Web site at:

Tabs3.com/support/docs.html
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